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Lesson 1: Event Handler 
 
Purpose 
The purpose of this workshop is to create two Events in Event Handler, for use in your study.  The first 
Event will ask for identifying information from your participants, and the second Event will include both 
of the two new measures you created.  Event Handler is a program that will help you create web pages for 
administering questionnaires and tests over the Internet.  It is possible (but not advisable) to do on-line 
research using only Event Handler.  This is a bad idea because Event Handler does not have any way for 
you to have a consent form or a debriefing form, and does not allow you to give different instructions for 
each test or questionnaire when you have multiple measures in your study.  Therefore, you really do need 
to use other programs in addition to Event Handler, in order to do on-line research. 
 
Prerequisite 
No prerequisites are required to start this lesson. 
 
Getting a Permanent Account 
I have obtained temporary Event Handler accounts for you for this workshop.  If you are designing a real 
study, you should get your own Event Handler account.  Otherwise you will be very upset when the 
temporary accounts are deleted at the end of the semester.  If you design multiple on-line studies, I 
recommend that you get a separate Event Handler account for each study.  This makes it easier to keep 
track of your files.  If you need a permanent account, email Kody Kearns at kody.kearns@unlv.edu 
immediately to set up the account.  The UNLV web site says that Event Handler accounts will only be 
given to faculty members, and so it may be wise to ask your faculty mentor to email Kody. 
 
Logging In 
1. Open a web browser, such as Internet Explorer or Firefox.  In theory, you should be able to use any 

web browser.  However, one student reported difficulties when using Event Handler with Firefox, and 
so you may prefer to use another browser. 

2. Go to the Event Handler web site at http://faculty.unlv.edu/dond/facultyWeb/eventhandler.html   
3. Click Login Now 
4. Enter your User ID and password.  I will hand these out to you if you want a temporary account.  

Please note: ID’s and passwords are both case-sensitive. 
 
Logging Off 
1. Take a look at the main screen you are on.  You will notice that there is no button that says log off.  

To log off, you will click the words User Login near the top.  It’s written in very small print.  Go 
ahead and log off now. 

2. This version of Event Handler uses cookies, and it will save your login and password in a flat text file 
on the computer you are using.  The next time someone goes to the Event Handler homepage using 
that computer, your login and password will already be filled in.  As you can see from the screen, 
your ID and password have already been filled in.  All someone has to do to get into your account is 
click “Login”.  To prevent this from happening, you need to delete the cookies on that computer. 
a. If you are using Internet Explorer, you can use the link that says "Clearing your Cookies".  It is 

part-way down that screen.  If you are using Internet Explorer, click that now.  Then refresh the 
Event Handler login screen, and you will see that the ID and password are now blank. 

b. If you are instead using Firefox, the link doesn't work.  Instead, click on the Tools menu, click 
Clear Private Data, and select Cookies.  Then click Clear Private Data Now.  Then refresh the 
Event Handler login screen, and you will see that the ID and password are now blank. 

c. You can also prevent the cookies from being put on your computer in the first place.  This won't 
work for the computers in the computer labs, because their settings are reset every evening.  But 
you can do this on your home or research-lab computers.  Blocking all cookies will interfere with 



the operation of some web sites, though.  If you want to Block Cookies, here's what you do.  In 
Internet Explorer, click Tools, Internet Options, Privacy, Settings (Scroll all the way up to “Block 
All Cookies”), and Apply (or OK).  In Firefox, click Tools, Options, Privacy. Then uncheck the 
box for “Accept Cookies from Site” and click Apply (or OK). 

3. Now that you have cleared your cookies, go ahead and log into your account again. 
 
Set Your User Settings 
The first time you sign on, you need to set your User Settings.  These are shown on the screen when you 
first sign on. 
1. Change your password to something you can remember.  Do NOT leave the password as it is.  If you 

do, someone else in the class might accidentally sign onto your account, and accidentally mess up all 
the work you are doing for your project. 

2. Provide an email address.  This is the return email address that will be used when you ask Event 
Handler to email your participants, and must be a functioning email address from one of your team 
members.  Even if you do not ask Event Handler to email participants, you must provide an email 
address or your web site may not work properly. 

3. Uncheck the box that says Disable All Events.  Currently, this box is checked, which means all your 
events are disabled.  You want to uncheck it. 

4. Provide a Title for your events.  I usually use the name of my study, and I get a separate Event 
Handler account for each study. 

5. Scroll down to the bottom, and click on Set User Settings. 
NOTE: In Event Handler, there are a lot of options.  Feel free to play with them if you want.  But be 
warned that several students have broken their web sites by setting some of these options to inappropriate 
values.  Therefore, if you do play with any other options, I recommend you set them back to the original 
values after you have finished exploring. 
 
Creating the First Event 
We will create two Events.  The first one is a short questionnaire that will collect identifying information 
(such as name).  The second Event will include the two new measures you created for Lab 1.  In the 
future, if you are designing a study in which participants will be anonymous, you would not need an 
Event that collects identifying information; and unless your study is very long, you will be able to put all 
of your questionnaires and tests in a single event.  However, for this course, we will assume that all 
participants get some type of reward for their participation and that they are not anonymous.  To make the 
first Event, which collects identifying information: 
1. Click on the drop down box User Admin Navigation. 
2. Click on Create Event.  Note: if you have just changed your password, Event Handler may take you 

back to the login page before it lets you create a new event.  If it does that, just type in your new 
password, and then create your new event. 

3. Enter a Title.  I usually use the name of my measure, here.  For example, I would use “Identifying 
Information.”  You can change this in the future. 

4. Enter a Filename.  The filename should be all lower case, with no spaces and no special characters.  
For example, I would use “identify”.  You cannot change the filename in the future. 

5. Click Create New Event. 
6. Click where it says to Click here to setup your new event.  In the future, if you want to modify an 

existing event, click on Event menu, and select your event from among the current, coming, and 
future events.  This will take you to first section under the Event Navigation menu.  This section is 
called Settings. 

NOTE: There are A LOT of options for how you set up your event.  Here’s the minimum you need to do 
for the identifying information questionnaire page.  Remember to be careful if you play with any other 
options, because this can break your web site. 
7. Under Event Settings, click on drop down box for Type.  Select Survey. 



8. Under Event Settings, the Event Title and Event Filename will already be filled in.  If you want to 
change the Event Title, you would do that here.  You cannot change the Event Filename. 

9. Under Event Settings, provide a brief Event Description.  I would say, “Identifying information 
needed to give participants their reward” 

10. Under Event Settings, provide an email address. This must be a real email address from one of the 
team members. 

11. Under Time/Date Settings, provide a Start Date, using the specified format.  Without a start date, no 
one can complete your questionnaire or test.  If you want people to be able to complete it right now 
(which is a good idea, because then you can complete it yourself and see if it works), set the Start 
Date to sometime in the past. 

12. Scroll to the bottom, and click Set Event Settings. 
13. Now you need to decide what questions will be on your identifying information questionnaire.  Your 

questionnaire must contain separate questions for First Name and Last Name. Your questionnaire 
must also ask participants for their email address, so we can send them an email that thanks them for 
participating and provides them with proof of their participation. 
* If your intended participants are students, you should also ask for student number. 
* If your intended participants are non-students, you should ask for any other identifying information 
(such as address and phone number) that you will need to give participants their reward for 
participating.  If you are asking someone for their address, break this question into several sub-
questions, in order to be sure you have all the information you need (for example, Address, Suite, 
City, State, Zip Code).   

NOTE: Take a minute now to decide what questions you will be asking.  For these workshops, we will be 
asking; first name, last name, student number, and email address. 
14. Now you are ready to enter your questions.  In Event Handler, there are two places where you can 

create questions.  For the first Event, we’ll be using the Demographic Fields section.  For the second 
Event, we’ll be using the Questions section. 

15. Click on the Event Navigation Menu, and select Demographic Fields. 
16. Locate the questions you will be using, and click Use on the right-hand side.  Do NOT ask 

participants for their gender – that kind of question will be put in the second Event, so that you can 
test the relationship of those variables to your questionnaires.   

17. For this questionnaire, participants absolutely MUST enter all of the requested information.  
Therefore, for pretty much every question you will be using, you also need to click Require on the 
right-hand side.  The only exceptions would be questions such as “Suite number” as part of an 
address: not everyone has a Suite number, and so you wouldn’t want to make it required.  When you 
are selecting your questions, remember that you need to provide separate questions for first name and 
last name; these are located at the bottom of the screen. 

NOTE: In general, you should NOT make ANY questions required, unless absolutely necessary.  Here, 
we absolutely must have this information in order to give rewards to participants.  In your second Event, 
which includes the new measures you wrote, the questions will NOT be required. 
18. For each question, the Field Name (on the left) is the name of the variable when it is sent to the 

database.  The Translation (on the right) is what is shown on the screen when the participant is 
completing your questionnaire.  You cannot change the Field Name but you can (and sometimes 
should) change the Translation.  If you need any items that are not currently listed, enter a new Field 
Name at the bottom.  Use only letters, numbers, and the underscore character (no spaces).  Make sure 
you also enter a Translation for these new items, or they will not show up on the screen shown to 
participants. 

19. For each question, enter an appropriate Translation. 
20. Next, decide what order the questions should go in.  First and last name should go first. Then ask for 

the other questions, in whatever order makes the most sense to you.  Indicate the order of the 
questions on the left-hand side, in the Order column. 



21. For each question, select the appropriate item Type using the drop-down menu.  If you are not sure 
what some of them are, try them out and see what they do.  You can come back and change this later. 
a. For many of your questions, you will use a textbox. Event Handler refers to this as Type = Text. 
b. If you are collecting physical addresses, then State should be given as a drop-down menu.  Event 

Handler refers to that as Type = Select. 
c. For all questions the use drop-down menus, list all possible responses in the box labeled Choices.  

Then, in the Size box, change the size from 30 to 1.  This way, it will show one option at a time, 
and the respondent can scroll through the menu. 

d. For any items that use drop-down menus, type "Select One" as the first response option in the 
Choices box. This way, you won't mistake a lack of response for choosing the first option on your 
list. 

e. For any items with Select One as the first option, put Select One as the Default Value for the 
question as well, so that this is what is shown before the participant selects anything. 

22. Scroll to the bottom, and click Set Demographic Fields. 
 
Looking at Your Measure 
1. Click on the Event Navigation drop-down menu.  Select Settings. 
2. Click View Event (Admin View) or the public link URL. This will show you what your test or 

questionnaire will look like to other people.  Every time you click “View Event” a new window will 
be opened.  You should close these after looking at them, so you don’t get confused between the 
current version of your Event and old versions. 

3. If you don’t like how something looks (e.g., if you don’t like the response format or you have spelling 
errors) go back to the Demographic Fields screen and change it. 

 
Emailing Participants 
In the first Event, we have required that participants give us their email address, so that we can send them 
an email.  I use this to send my participants an email that proves that they participated in the study.  You 
may also want to use this email to send debriefing information to your participants.  For two-part studies, 
where the participant has to come back another day to complete the study, I also include information 
about how to find the second part of the study. 
 
Set the content of this email as follows: 
1. Go to the Settings screen for your questionnaire. 
2. Scroll down to Email Settings.  It’s roughly ¾ of the way down the page. 
3. Check the box that says Email Entrant 
4. Enter the Subject for the email.  Use the name of your study as the Subject. 
5. Enter the Message Body for the email.  Thank the person for participating, tell them how many 

credits they will be given or how much money they will be paid (or whatever other reward they have 
been promised), and tell them how to contact you.  If you wish to email a debriefing to participants, 
include your debriefing here. 

6. Scroll to the bottom, and click Set Event Settings. 
7. Click where it says to “Click here to return.” 
 
Redirecting Participants 
Now we need to tell Event Handler where we want participants to be sent after they submit the 
questionnaire. 
1. You first need to decide which Novell account you are going to put your study in.  Each of the people 

working on the project has a different Novell account, and your team also has a group account.  You 
will put the web pages in the home directory of just one of those accounts.  You will need access to 
that account EVERY time you want to work on the web site, and so you may want to use the group 
account.  On the other hand, the group account is temporary, and will be deleted at the end of the 



semester.  Decide which account you will use.  Write it down here for easy reference.  The name of 
your group account is the name of your group, which you selected in Lab 3. 

2. Next, you need to decide the name of the folder that you will put the study in.  I recommend using the 
name of your study, all in lowercase.  Write it down here for easy reference.  Note: If you have named 
your group after the name of your study, and you are using your group account, that’s fine.  The 
folder and the account will be the same.  If so, the first page of your web site might be something like 

http://complabs.nevada.edu/~child/child/index.htm 
If you don’t want the account and the folder to be the same, you can use a different name for the 
folder.  For example, 

http://complabs.nevada.edu/~child/study1/index.htm 
3. On the Settings screen for your questionnaire, scroll down until you get to the Static Pages section.  

It’s roughly half-way down the page. 
4. For Correct Redirect URL, enter the address you will use for your second questionnaire.  Your URL 

will be:        http://complabs.nevada.edu/~yourlogin/foldername/second.htm                                       
where “yourlogin” means your Novell login (your Novell login is the one you use to sign on to the 
computer, not your Event Handler login; if you are using your group account, use your group name 
instead) and “foldername” is the name of the folder in which you will put your study.  Later on you 
will create a web page that has your second questionnaire, the one with all of your interesting 
measures.  It will be called second.htm 

5. Under Incorrect Redirect URL, enter the address of your second questionnaire page again.  A 
submission is considered “Incorrect” if it is completely blank, even if you didn’t indicate that any of 
the questions had to be answered.  Therefore, you need to provide an Incorrect Redirect URL as well 
as a Correct Redirect URL. 

6. Scroll down to the bottom, and click Set Event Settings. 
 
Creating Your Second Event 
1. First you need to decide how many questions you will be on your second event.  This Event will have 

at least 27 items: the items for your two new measures, plus 3 more items.  If you wrote 12 items for 
each measure, then this Event would have a total of 27 items.  If you wrote 18 items for each 
measure, it would have a total of 39 items.  Take a minute now to count how many questions you 
have. 

2. Create a new Event, using the same steps as you did for the identifying information questionnaire. 
3. Set the Settings for this new event, using the same steps as before. There will be three modifications. 

a. Do NOT create an email to send to the participant – you won’t ask for their email address on this 
questionnaire and you don’t need to send them another email. 

b. When participants hit the Submit button, you want the web site to take them to the debriefing 
form.  Therefore, under Settings, Static Pages, Correct and Incorrect Redirect URL, enter the 
location of your debriefing form, which is 

http://complabs.nevada.edu/~yourlogin/foldername/debrief.htm 
where “yourlogin” means your Novell login (your Novell login is the one you use to sign on to 
the computer, not your Event Handler login; if you are using your group account, use your group 
name instead) and “foldername” is the name of the folder in which you will put your study.  Later 
on you will create a web page that has your debriefing information.  It will be called debrief.htm 

c. At the very bottom of the Settings page, under Question Settings, set the Number of Questions 
you want in total.  Later on, if you decide that you want to add more questions, you can come 
back here and change the number of questions.  Leave the Question Flow Format as Single Page. 

4. Now you are ready to enter your questions.  Click on the Event Navigation menu and select 
Questions. 

5. Enter your first three questions in the Question boxes.  The first three items will be sex, age, and 
ethnicity.  Sex should use radio buttons; age should use a drop-down box with options for ages from 
18 to 100 (list every number between 18 and 100, inclusive; this is tedious, but necessary); and 



ethnicity should use a drop-down box. For ethnicity, you may use whatever options you think are 
sensible; but if your options are not exhaustive, use "Other" as the last option in the list. 
a. Enter the question itself in the box labeled Question.  Do not leave this blank with the intention of 

filling it in later; if you do, Event Handler will erase the question. 
b. For each question, select the appropriate item Type using the drop-down menu.  If you are not 

sure what some of them are, try them out and see what they do.  You can come back and change 
this later. 

c. You do not need to fill in the Order of the questions.  Event Handler will fill that in for you if you 
leave it blank.  Later, if you want to change the order of your questions, you can change those 
numbers. 

d. Now you can enter the possible responses.  Leave the box that says “Correct Answer” blank.  
You will leave this box blank even if your questions have right and wrong answers. 

e. For each closed-ended question, list all possible responses in the boxes labeled Choices.  You will 
need a separate box for each choice. 

f. For Multiple-Choice items (and any other items that use drop-down menus), remember to use 
"Select One" as the first response option. This way, you won't mistake a lack of response for 
choosing the first option on your list.  If you have already typed the response options for each 
question, go ahead and enter Select One as the last option.  You can then rearrange the order in 
which the response options are shown, using the Order boxes to the right of the Choices boxes: 
make Select One the first choice, and then put the other choices in the order you want. 

g. You will run out of space while typing the options for Age. Scroll to the top and enter the desired 
number of Additional Choice Options.  Then scroll to the bottom, and click Set Questions.  
Finally, go back into the Questions screen to add more options.  Once you have as many options 
as you need for the long question, you can reduce the number of Additional Choice Options while 
you are setting up the remaining questions; this will make the web page shorter and faster. 

7. Now enter Item Labels for your remaining questions.  The remaining questions will be the ones given 
to you.  The first set of items are the ones for the first measure, and have the response scale that is 
used for that measure.  The second set of items are the ones for the second measure, and have the 
response scale that is used for that measure.  There are a few different ways that you could enter your 
items into Event Handler, but some of these methods are better than others.  Read the following two 
boxes before creating the questions. 
 
 

Options for Entering Questions into Event Handler 
When you enter your questions into Event Handler, you have two options.  First, you can enter the 

content of the item.  If your first question on your measure of Conscientiousness is “I arrive at work on 
time”, you could enter that entire sentence into Event Handler.  The advantage of this is that when you get 
your data, you know exactly what question the respondents were answering.  The second option is to 
enter item labels.  For example, if this is the first item on your 12-item Conscientiousness scale, you could 
enter “con1”.  There are three advantages of using this approach.  First, it will make it easier to import 
your data into SPSS.  Second, it is easier to make changes later (such as fixing typos, changing the order 
of items, or incorporating feedback).  Third, it will help protect the confidentiality of your data; if an 
unauthorized person accesses your data, the data itself will be meaningless.  The disadvantage is that you 
have to keep a list of the item content with the item numbers, so that you know what question respondents 
were answering.  This is pretty easy, though, and you can always look back at your web pages.  For this 
project, use item labels, because this will make it easier to do item revisions.  To make it easier to import 
your data into SPSS, use labels that 1) identify the measure and the item number, 2) are all lower case, 3) 
contain no spaces or special characters, and 4) are 8 characters or less.  (SPSS version 13, 14, and 15 are 
more forgiving about labels, but in case you want to import the data into an older version of SPSS, it’s 
best to follow these old restrictions on labels). 



When your enter Choices into Event Handler, you have three options, regardless of how you lay out 
the response options on the actual web page that participants see.  First, you can enter the meaning of the 
responses (e.g., Strongly Disagree, Disagree, Neutral, Agree, Strongly Agree) in Event Handler.  For 
example, you might have respondents select the option Strongly Disagree or the number 1, but in either 
case, the meaning is “Strongly Disagree”.  The advantage of entering the complete meaning is that you 
know exactly what a respondent meant by their response.  The second option is to use abbreviations of 
what the respondent meant (e.g., SD, D, N, A, SA).  The advantage of this is that you know what the 
respondent meant, and the data takes up much less screen space when you are looking at it in SPSS.  The 
third option is to use numbers instead of words (e.g., 1, 2, 3, 4, 5), regardless of whether the respondent 
saw numbers with the words or only saw the words.  One advantage of this is that the data does not need 
to be transformed before analyzing it in SPSS.  Another advantage is that it helps protect the 
confidentiality of your data, as long as you do NOT use the multiple choice format (see next section).  
Personally, what I do is I show respondents the response scale (e.g., 1 = Strongly Disagree, 2 = Disagree, 
3 = Neutral, 4 = Agree, and 5 = Strongly Agree) and ask respondents to choose between the numbers to 
indicate their response, and in Event Handler I enter the numbers.  The disadvantage of this approach is 
that you have to keep track of the relationship between the numbers and the meanings of the responses, 
but you can always look back at your web page for this information.  For this project, use only numbers to 
indicate which responses participants made. 

 
 
 

Response Format and Confidentiality 
Using radio buttons and checkboxes protects the confidentiality of data better than using multiple-

choice (drop-down menus).  When you use radio buttons and checkboxes, response options are broken 
into two parts.  The first part is what the participant sees on the screen.  The second part is what is sent to 
the EventHandler database.  Because these are separate, they can be different.  And so if someone selects 
the option that says “Yes, I have stolen a car in the last year”, the information that is sent to EventHandler 
might say “c”. 

When you use multiple-choice, what is shown on the screen is exactly the same as what is sent to 
EventHandler.  Therefore, if you are asking any questions where a breach of confidentiality might harm 
your participants, you should either avoid multiple-choice, or design your questions so that the response 
options are innocuous.  For example, here are two ways the above question could be asked: 
 Have you ever stolen a car? 
  a. I have never stolen a car 
  b. I stole a car once a long time ago 
  c. I stole a car in the last year 
 When was the last time you stole a car? 
  a. Never 
  b. A long time ago 
  c. In the last year 
The second question will protect confidentiality even if a multiple choice format is used. 

There is one additional disadvantage of multiple choice options.  If a participant has selected an item 
and indicated their response and then uses the scroll button on their mouse to try to move down the 
screen, this will change the response option that is indicated.  Participants may not realize that they have 
accidentally changed their response.  Web site designers sometimes use multiple-choice items anyway, 
because it takes up less screen space than radio buttons.  For this project, with the exception of Age and 
Ethnicity, do not use drop-down menus. 

Always avoid using checkboxes. They make it hard to analyze your data because different 
respondents will have different numbers of questions in the database.  So, if you have a checklist of items, 



do not use checkboxes; instead, make each item a dichotomous yes/no or present/absent question using 
radio buttons or multiple-choice. 
 

What to Hand In 
When you finish this workshop, please let Samantha or Jacqueline know so we can check it over real 
quick.   



Lesson 2: Dreamweaver 
 
Purpose 
The purpose of this assignment is to create the five web pages that participants will see when they 
complete your study.  You will copy and paste most of the content of these web pages from Microsoft 
Word and Event Handler, and then you will use Dreamweaver to format this content.  The five web pages 
are a consent form, two questionnaires, a debriefing form, and a “no thank you” page. 
 
Prerequisites 
You should have successfully completed Lesson 1: Event Handler, before attempting this lesson. 
 
30-Day Trial Period 
You can use Dreamweaver for free for 30 days.  For example, you may wish to download it on your 
computer at home.  Go to the Macromedia web site at http://www.macromedia.com and follow their 
instructions.  We are using Dreamweaver 8 (also called Dreamweaver CS2) in CBC B135.  If you 
download a free trial from the Macromedia web site, you will be using Dreamweaver CD3, which is 
slightly newer.  The instructions should be nearly identical for the two versions of Dreamweaver, and the 
files you create in Dreamweaver CS3 should work just fine in Dreamweaver 8, as long as you constrain 
yourself to basic web design. 
 
If you do download a copy of Dreamweaver onto your home computer, remember that you will need to 
copy the files that you create at home onto the public_html folder of your Home Directory at school, 
before these pages can be seen on the Internet.  You can use a flash drive or upload them from home 
using complabs.nevada.edu. 
 
Opening Dreamweaver 
Dreamweaver is published by Macromedia and is available on most computers on campus.  You should 
find it under the Start button, under either Programs or Applications.  It may be under a submenu called 
Macromedia.  If you have difficulty locating it, ask the lab monitor for help.  Remember lab monitors can 
help you log into your account and find programs on the computer, but they cannot help you use the 
programs and so cannot help you with these assignments. 
 
Creating a Web Site 
A web site consists of several web pages that are linked together.  Before creating web pages, we need to 
create the overall web site. 
1. Make sure that you are logged onto the Novell account that you want to save your files under.  You 

will only be able to access your files when you are logged onto this account. 
2. Open Dreamweaver. 
3. Click on the Site menu from the toolbar at the top of the window. 
4. Click on Manage Sites from the drop-down menu.  This will bring you to the Manage Sites window.  

Click on New and then click on Site from the drop-down menu.  This will bring you to the Site 
Definition window. Make sure that the Basic tab is selected. 

5. Give the site a Site Name.  I use the name of my study.  Then click Next. 
6. Indicate that you do not want to use server technology, and then click Next. 
7. Indicate that you want to edit directly on the server using local network. 
8. To specify your local folder, click on the folder icon and navigate to the H or P directory.  Go into 

your public_html folder. 
WARNING: This method of setting up the web site will only work if you are working in a computer lab 
at UNLV.  If you want to work on your web site at home (for example, using a free trial version of 
Dreamweaver) you will still need to set up your web site exactly as given above, but when you get to Step 
8, you should select a folder on your harddrive.  Then, when you want to update your web site using files 



you have worked on at home, you will need to copy your files into the H: or P: public_html folder.  You 
can do this using a flash drive.  It is possible to set up your web site so that you can work on it directly 
when you are not at UNLV, but that is not part of this course.  It is also possible to access the H or P 
directory directly when you are at home, but this is not a part of this course. 
9. Create a new folder for this study.  This way, you will be able to have multiple web sites in your 

public_html folder (just put each in a different folder).  To create a new folder, click on the folder 
icon with the star on it, at the top of the window; it’s the second symbol from the right.  Type the 
name of the new folder.  Remember that you already decided what you were going to name this 
folder, in the last assignment, when you told Event Handler the Redirect URLs.  Make sure you use 
exactly the same name here. 

10. Double-click on the new folder to open it.  Click Select.  This will bring you back to the Site 
Definition window.  Now click Next.  Click Done.  This will bring you back to the Manage Sites 
window. Click Done. 

NOTE: The computers in each of the computer labs are reset every evening.  Therefore, they will not 
remember your site definition the next day.  Every time you sit down to work on your web site in 
Dreamweaver, you will need to set up your web site using Steps 1 – 8 and Step 10 (you do not have to 
create a new folder each time).  Don’t worry, you’ll get very fast at defining your site. 
 
Creating Your Web pages 
Each web page is stored in a separate file and has to be created separately. 
 
To create your consent form (index.htm) 
1. Click on the File menu  
2. Click on New from the drop-down menu.  This will bring you to a window that lets you select the 

type of file it will be. 
3. In the Category box, click on Basic Page. 
4. Click Create. 
5. Copy and paste the text of your consent form, which you created previously, into the blank page.  If 

Dr. Barchard suggested modifications to your consent form, you will need to make those 
modifications before you hand in your final Project 1, but you do NOT have to make those changes 
now.  It will be just as easy to make those changes when the text is in Dreamweaver as when it was in 
Microsoft Word. 

6. On the UNLV consent form template, the first line is the UNLV logo.  Use the logo that was designed 
to be displayed on the Internet.  You can find it at http://web.unlv.edu/images.html 
To download the picture, right-click on the picture, and select Save Image As.  Save the picture to the 
appropriate folder inside your public_html folder.  Remember, all files for your web site have to be 
inside this one folder.  Then go back to Dreamweaver, and use Insert / Image to insert this image into 
your web page.  When you insert the UNLV logo image, a dialogue box will appear, which allows 
you to provide alt text for the image.  The alt (alternative) text is the text that appears when you 
mouse over an image, and is read by web page processing programs for the visually impaired.  Add 
the alt tag "UNLV Logo". 

7. Make sure that you use the headings from the UNLV consent form template (Informed Consent, 
Department of Psychology, name of study) 

8. Using the Properties window at the bottom of the screen, center the headings at the top (Logo, 
Informed Consent, and Department of Psychology) and change the font size so that they are larger 
than the rest of the text. 

9. Using the Properties window, format the rest of your consent form so that it is easy to read.  If you 
want to use Styles to format your document, I recommend that you select your ENTIRE page, apply 
the same style to ALL the text, and THEN change the size, alignment, and bold and italics of the 
different parts.  You do not have to use Styles at all. 



10. Near the bottom of your consent form, be sure to ask participants if they have any questions.  This 
should already be on your consent form, but it if isn’t, add it now.  Tell them to email you (and give 
your email address) if they have any questions.  If you do not want to give your real email address, 
use fakeemail@fakeemail.com 

11. At the very bottom of your consent form, you should ask participants if they consent to participate.  
Give them two options to choose between, in order to respond.  For example, “Yes” and “No”, or “I 
consent” and “I do not consent.”  Later on, we will turn these two options into links that take the 
participant to the appropriate pages.  You should have already written the text that you were thinking 
of using for this question and these two options, but if not, add this now. 

12. When you first create the “I consent” and “I do not consent” links, Dreamweaver will put these right 
next to each other. To make these easier to read, we’ll put them in a table.  Click on Insert, Table.  
Indicate that your table will have one row and two columns.  Click OK.  Then copy and paste your 
two links into the table.  Next, adjust the size of the table so that it is easy to read.  I usually center 
this table as well.  If you want to center the table, select the entire table, and then under the Properties 
window, select Align = Center. 

13. Make sure that everything on your consent form is clear and easy to read. 
14. Every web page needs to have a title.  Adding a title is NOT the same as putting the name of your 

study at the top of the page, which you did in step 6.  The title of the web page is what shows up in 
the title bar at the top of the window.  In Dreamweaver, you can enter the title of the page in the box 
at the top of the screen, labeled “Title”, which currently says “Untitled Document”.  Give your page a 
new title.  I use the name of my study. 

NOTE: Failure to specify titles is the most common error in creating web pages. 
 

To save your file 
You have now created a web page.  You need to save your file.  It is important that the first page that 
people will see in your web site has a particular file name.  It must be called “index.htm” or “index.html”.  
So, save your consent form as “index.htm”. 
 
Naming Files 
For this project, I will tell you exactly what to call each of your files.  However, I’d also like to give you 
some general guidelines about the types of file names you should use in the future, when saving your html 
pages.  You should always use very simple file names, to avoid having trouble loading your web pages 
later.  Follow these guidelines: 
1. You can use either htm or html as the extension, but index.htm and index.html are different files.  

Personally, I use htm, because most files have three-character extensions. For this project, we'll all 
use htm so that I know the names of your files. 

2. Use all lower case.  Many people will tell you that it doesn’t make a difference if you use upper case 
or lower case, but this is not true.  Index.htm and index.htm are different files according to some 
programs and the same file according to other programs, causing problems with uploading files and 
reading them (and difficulties in remembering what your file names are). 

3. Use letters, numbers, and the under-score character.  Do not use any other characters and do not use 
spaces in your file names. 

4. Keep file names short. 
5. Make sure your file names are easy to recognize and are specific to the document they are describing.  

For example, I use the following file names:   index.htm     consent.htm nothanks.htm     
name_of_my_test.htm      debrief.htm 

Save your consent form as index.htm on your H or P drive, in the public_html folder, in the folder you 
created for your study. 



To create your No Thanks page (nothanks.htm) 
When participants state that they do not want to participate, you should thank them for their interest, and 
let them leave. 
1. Start a new page, by clicking on the File menu. 
2. Click on New Page from the drop-down menu. 
3. Select Basic Page, and click Create. 
4. Put a heading on your No Thanks page.  The heading is the words at the top of the screen.  The 

heading I use is the name of my study. 
5. Center the heading and change the font size of the heading so that it is large. 
6. Thank participants for their interest and tell them they can come back if they want to participate later. 
7. Suggest that participants return to the UNLV homepage, by typing “Return to UNLV Homepage”.  

We will turn these words into a link in a little while. 
8. Make sure that everything on this page is clear and easy to read. 
9. Put a title on your page.  I use the name of my study. 
10. Save your page as nothanks.htm on your H or P drive, in the public_html folder, in the folder you 

created for your study. 
 
To create your debriefing form (debrief.htm) 
When participants complete a study, we are ethically required to debrief them, telling them the purpose of 
our study and answering any questions they have. 
1. Start a new page, by clicking on the File menu. 
2. Click on New from the drop down menu. 
3. Select Basic Page, and click Create. 
4. Put a heading on your debriefing form.  The heading I usually use is the name of the study followed 

by “Debriefing”. 
5. Center the heading and change the font size of the heading so that it is large. 
6. Copy and paste the text you created for your debriefing page in your earlier assignment.  If Dr. 

Barchard suggested modifications to your consent form, you will need to make those modifications 
before you hand in your final Project 1.  But you do NOT have to make those changes now.  It will be 
just as easy to make those changes when the text is in Dreamweaver as when it was in Microsoft 
Word. 

7. Near the end of your debriefing, tell participants that if they have any questions, they can email you.  
Give your email address.  Use fakeemail@fakeemail.com if you do not want to give your real email 
address. 

8. Suggest that participants return to the UNLV homepage, by typing “Return to UNLV Homepage”.  
We will turn this into a link in a little while. 

9. Make sure that everything on this page is clear and easy to read. 
10. Put a title on your web page.  I use the title of the study, followed by the word Debriefing. 
11. Save your file as debrief.htm on your H or P drive, in the public_html folder, in the folder you created 

for your study. 
 
To create your identifying information questionnaire page (identify.htm) 
1. Create a new blank page. 
2. Add a heading to your page.  I use the name of my study. 
3. Center your heading and change the font size of your heading so that it is large. 
4. Give your web page a title. 
5. Save your file as identify.htm on your H or P drive, in the public_html folder, in the folder you 

created for your study. 



Now we need to take the HTML code that we created in Event Handler, and paste it into Dreamweaver. 
6. Click on the Code View button at the top left.  It looks like this: <> Code.  Alternatively, you can 

click on the View menu, and select "Code".  Code View shows you the HTML commands that are 
being used to generate the web page. 

7. Minimize the Dreamweaver window. 
8. Open Internet Explorer or Firefox and log into the Event Handler web site.  The address is 

http://faculty.unlv.edu/dond/facultyWeb/eventhandler.html 
 

Now we’re ready to copy and paste the questionnaire into Dreamweaver. 
9. Click on Events. 
10. Select the Event that contains the Identifying Information. 
11. Click View Event (Admin View) 
12. Examine your questionnaire, and make sure it looks like you want it to.  In particular, make sure that 

you have all the questions you want and that the response format is appropriate for each question.  If 
Dr. Barchard suggested changes to the content of your questions, incorporate those changes before 
pasting the HTML into Dreamweaver. 

13. Locate the window that has the HTML code that generates this web page.  Sometimes it is at the top, 
on the right hand side.  Sometimes it is at the bottom.  Click the button under that window that says 
Select All. 

14. Click on the Edit menu. 
15. Click Copy from the drop-down menu. 
16. Switch to the Dreamweaver window. 
17. Click on the page, so that your cursor is right before the </body> tag. 
18. Click on the Edit menu. 
19. Click on Paste from the drop down menu. 
20. Click on the Design View button at the top left of the window to see what your web page looks like.  

This button is two buttons to the right of the Code View button. 
21. Save your file. 
 
Now that we have the basic HTML code in Dreamweaver, we’ll want to clean it up a little bit. 
22. Remove the links at the top of the page that say “Events” “Entry Form” “Recommend to friend” and 

“Go Back”.  Just select them and hit the delete key. 
23. Remove the links at the bottom of the page that say the same. 
24. You will notice that there are some strange yellow symbols on your page.  These are critically 

important pieces of information needed to get your data sent to Event Handler and to get participants 
sent to the next page in your study.  You need to leave them all there or your web site won’t work.  
Don’t worry, they won’t show up on the screen when you look at your web site in Internet Explorer.  
Later on, if you hit the Submit button and strange things happen, the deletion of these symbols is 
usually the problem. 

25. Make sure everything is clear and easy to read.  In particular, make sure that ALL of your text is large 
enough to be read easily. 

26. In case some of your participants decide not to participate, there should be SOME way that they can 
exit this page without providing the information requested.  At the bottom of the page, add the words 
“Quit the study now”.  Later, we’ll turn this into a link to the nothanks.htm page. 

27. Save your file.  In fact, save your file regularly while you are working. 
28. Check the formatting of your web page by previewing it in one or more browsers.  To preview your 

web page, you can click on File, Preview in Browser.  Alternatively, you can click the Preview 
button.  It's circled in red in the following picture:  
 



 
29. If you revise your web page, save it again.  

 
To create your second questionnaire page (second.htm) 
1. Create a new blank page. 
2. Add a heading to your page, center it and make it large. 
3. Give your web page a title. 
4. Save your file as second.htm on your H OR P drive, in the public_html folder, in the folder you 

created for your study. 
5. Copy the HTML code from the second event in Event Handler and paste it into Dreamweaver, using 

the steps given above for the Identifying Information page. 
6. This web page has three separate measures.  See the example on the next page for an example of what 

your final web page will look like.  The first questionnaire has three demographics questions.  The 
second and third measures are the new measures you wrote.  We want to put separate titles on these 
three measures.  Right now, all of the questions on your measures are currently inside a single table. 

NOTE: You need to divide this into three separate tables.  One way to do this is to insert several blank 
lines after the table (but before the Submit button), cut the rows that have the last measure, and then paste 
them a few lines further down the page.  Next, select the middle measure, and paste them a couple of lines 
down the page, between the demographics questions and your last measure. 
7. Now you can add the titles of your measures.  Above the demographics measure, type Demographics.  

Above your first measure, add the title for that measure (usually its name).  Above the second 
measure, add the title for that measure.   



Example formatting for second.htm 
 

The Happiness Study 
 

Demographics 
Sex 
Age 
Ethnicity 
 

Depression Questionnaire 
Instructions: Please answer each of the following questions using the following rating scale 1 = disagree, 
2 = neutral, 3 = agree. 
dep1 
dep2 
dep3 
dep4 
dep5 
dep6 
dep7 
dep8 
dep9 
dep10 
dep11 
dep12 
 

Life Satisfaction Questionnaire 
Instructions: Please answer each of the following questions using the following rating scale 1 = never, 2 = 
sometimes, 3 = often, 4 = always. 
ls1 
ls2 
ls3 
ls4 
ls5 
ls6 
ls7 
ls8 
ls9 
ls10 
ls11 
ls12 
 
Submit 
 
Quit the study 

 
 



8. In a previous assignment, you wrote instructions for each of your measures.  Insert these at 
appropriate places in your web page, right after the titles for the measures and right before the 
questions.  If Dr. Barchard suggested that you modify these instructions, you need to make those 
changes before you submit your final project, but you do not need to make those changes now. 

9. You’ll see that Dreamweaver has numbered all of your items in order.  However, it will make more 
sense if the items on your two questionnaires start with item 1.  Change the numbers under each 
measure so that they start at 1. 

10. Now you can add the item content to each measure.  Replace each item label with the appropriate 
item.  For example, if the first item on your conscientiousness measure is “I am very conscientious”, 
replace the label “con1” with the statement “I am very conscientious”.  If Dr. Barchard suggested 
modifications to your items, you do not need to make those changes now.  For now, just copy and 
paste the items from Microsoft Word.  It will be just as easy to fix the item wording in Dreamweaver 
as it is in Word. 

11. Now modify the response options if you want.  You set up Event Handler so that the information that 
will be sent to Event Handler is numbers.  The default option is that respondents will see the same 
information as is sent (i.e., numbers).  If you want the respondents to see words instead of numbers, 
or words in addition to numbers, you need to set that up in Dreamweaver.  For example, right now 
respondents might see “1”, but you might want them to see “Strongly Disagree”.  If you want to 
change these,  
a. for Radio buttons, just replace the numbers that are there with what you want participants to see. 
b. for multiple choice items, click on the box where the response options should be.  In the 

Properties panel, click on the List Values button.  Select the Item Label you want to change, and 
type what you want it to say.  Change all the response options you want to change.  Click OK. 

12. For each of your multiple choice items (including Age and Ethnicity) it would be helpful if the words 
“Select One” were visible when a person first sees the item.  To make this visible, select the box for 
the drop-down menu for the item.  Using the properties window, in the “Initially Selected” box, select 
the first option, which says “Select One”. 

13. Include an option to “Quit the study now” at the bottom of the page.  Later, we’ll turn this into a link 
that goes to the debrief.htm page. 

14. Delete the unnecessary links at the top and bottom of the page. 
15. Format your questionnaire so you like how it looks.  At this point, do NOT change the COLOR of 

any of the text (we'll do that later).  But you may just want to change the font sizes and styles and the 
alignment and spacing, or you may want to do something more elaborate, such as changing a vertical 
line of radio buttons into a horizontal row.  Formatting can take a LONG time; so take some time to 
plan how you will do this.  When working, keep in mind that the form objects (radio buttons, text 
boxes, multiple choice drop-down menus, etc) for different questions and different responses to the 
same question are all different from each other.  The computer knows which of these is for question 1 
and which is for question 2, etc.  So, when moving things around, make sure you don’t get confused 
about which object belongs with which question.  If you are doing a lot of reformatting, you may 
want to switch to Code View and use Find and Replace.  Find and Replace has two advantages: 1) it 
saves time and 2) it prevents errors.  Ask Dr. Barchard for ideas about how to reformat your 
questionnaire most efficiently. 

16. Preview your page to check the formatting. 
17. Save your file. 
 
Adding a Template 
To add some color to a web site, you can change the background color and font color of each individual 
page, or you can create a template and apply it to all of your web pages.  We will use templates. 
 

To create a template 
1. Click on the File Menu 



2. Click New 
3. In the Category box, select Template Page 
4. Under Template Page, select HTML Template  
5. Click Create 
6. At this point, you would add any text that you want to show up on EVERY page.  We’ll leave the 

page blank for this project, but in some future project, you might want some text to be the same on 
every page, and this is where you would do that. 

7. Click on the Modify menu. 
8. Click on Page Properties from the drop-down menu. 
9. Change the Background color to a light color which isn't completely white, by clicking on the little 

box and selecting a color you like.  More colors are available by clicking on the little colored circle.  
For future projects, unless you are conducting a study on color, you should use relatively neutral 
colors that will not overly influence how people respond to your study.  Whichever colors you select, 
make sure that it is easy to read your text against your background. 

10. Change the Text color to something dark that isn't completely black. 
11. Click OK. 
12. Click on the Insert menu 
13. Click on Template Objects 
14. Click on Editable Region 
15. Click OK 
16. Change the page title. 
17. Save your template in the template folder and in your public_htm folder.  Use the file name 

498template.  Dreamweaver will save this file with an appropriate extension, so do not worry about 
what extension it is given. 

 

Applying a template 
Now you need to apply this template to each of your individual web pages.  Open your five web pages, 
one at a time, and do the following: 
1. Click on the Modify menu 
2. Click on Templates from the drop-down menu 
3. Click on Apply Template to Page 
4. Select your template. 
5. Note that, by default, Dreamweaver will update your page every time you change the template.  This 

is good.  Leave it that way. 
6. Dreamweaver will complain that there are Inconsistent Region Names.  In the main box, select 

“Document body”.  In Move content to new region box, select the name of your editable region.  
Mine was called EditRegion3. 

7. Next, in the main box select "Document head".  In Move content to new region box, select head.  If 
there isn't a Document head for your file, you can skip this step. 

8. Click OK. 
9. When you apply the template to the page, the text color, background color, and title will all change. 

• You will NOT be able to change the background color on individual pages; you must change that 
on the template itself (or detach the page from template and either leave the page with no 
template or attach another template). 

• You will NOT be able to change the default text color on individual pages; once again you must 
change this on the template itself.  However, you can change the color of individual words on the 
page, such as headings.  If you want, you can change the color of individual words now. 

By the way, if you applied your template and some words did not change color, it is 
because you changed their color before you applied the template.  To switch back to the 
default color, select the words, and under the Properties box, click on the color for the 



text, and select the white box that has a red diagonal line through it (if you hover over 
this box, it says "Default Color"). 

• Finally, you WILL be able to change the title of the page.  If you want your pages to have 
different titles, you can change those now. 

10. Save your file. 
NOTE: From now on, if you change your template, all of your web pages will change automatically. 
 
Joining Your Web Pages Together 
When people do your study, you want them to start with your consent form, then go to your identifying 
information questionnaire, then go to your second questionnaire (which contains the two new measures 
you created), and then go to the debriefing page.  You will use links to move the participant from one 
page to another. 
 

Introductory Page 
1. Go to your index.htm page, which has your consent form on it. 
2. Select the word(s) that indicate that the participant wants to participate in your study.  On my page, 

these words are “Yes, I consent”. 
3. At the bottom of the page, under Properties, click on the folder icon next to the Link box. 
4. Locate the file that contains your first questionnaire, identify.htm   Select this file.  This way, when 

participants indicate that they want to participate, they will be sent to this questionnaire. 
5. Click OK.  You will notice that the name of this file shows up in the Link box. 
NOTE: Another way of doing this would have been to type the file name into the Link box directly.  I do 
not recommend you do this.  You are likely to make typing errors occasionally (or to forget your file 
names), in which case the links won't work. 
6. Select the word(s) on your index.htm file that indicate that the participant does not want to participate 

in your study.  On my page, these words are “No, I do NOT consent”. 
7. At the bottom of the page, under Properties, click on the folder icon. 
8. Locate the file that contains your “No Thank You” page, nothanks.htm.  Select it. 
9. Click OK. 
10. Save your file. 

This type of link is called a relative link because you have only specified the name of the file.  The 
location of the file is assumed to be the same directory as the file that you linked from. 
 

Debriefing Page 
1. Go to your debrief.htm page. 
2. Select the words “UNLV Homepage” 
3. At the bottom of the page, under Properties, type in the address in the Link box.  The address is 

http://www.unlv.edu/ 
4. At least one of your references should be a web site.  Provide a functional link to this web site.  If the 

URL address is unattractive or uninformative, use the name of the web site as the text that is shown to 
participants, but use the full address in the link box.  For example, the text could say “712 Course 
Web Site” and the link box could say 
“http://www.unlv.edu/faculty/barchard/712/712Spring08/P712SP08.htm”. 

5. Save your file. 
This type of link is called an absolute link because we have specified the entire URL address.  Please 
note: If you do not include the http:// the link will not work.  The web browser will think that 
www.unlv.edu is a relative link and that this is the name of a file that is a part of your web site: It will 
look for it inside your public_html folder and not find it. 

 

No Thanks Page 
1. Go to your nothanks.htm page. 
2. Select the words “UNLV Homepage” 



3. At the bottom of the page, under Properties, type in the address in the Link box.  The address is 
http://www.unlv.edu/ 

4. Save your file. 
 

First Questionnaire 
1. Go to your identify.htm page. 
2. Select the words “Quit the study now”. 
3. At the bottom of the page, under Properties, click on the folder icon. 
4. Locate the file that contains your “No Thanks” page, nothanks.htm.  Select it. 
5. Click OK. And then Save your file. 



Second Questionnaire 
1. Go to your second.htm page. 
2. Select the words “Quit the study now”. 
3. At the bottom of the page, under Properties, click on the folder icon. 
4. Locate the file that contains your “Debriefing” page, debrief.htm.  Select it. 
 Note: The link from the first questionnaire goes to the No Thanks page, because participants have not 

completed any measures in the study yet.  But the link on the Second Questionnaire goes to the 
debriefing page because participants have already completed part of the study. 

5. Click OK. And then Save your file. 
 

Email Links 
On both your consent form and your debriefing form, you have told participants that they can email you.  
In this section, we will convert those words into an actual email link. 
1.  Go to your Consent form, called index.htm 
2.  Select your email address. 
3.  At the bottom of the page, under Properties, type the following in the Link box.  Type “mailto:” and 

then type your email address.  For example, if I wanted to create an email link to my email, I would 
type mailto:barchard@unlv.nevada.edu 

NOTE: the email address that you use here should match the email address that is visible on the screen. 
4.  Save your file. 
5.  Go to your Debriefing form, debrief.htm, and create another link for your email address there.  Save 

your file. 
 

Checking Your Work 
To check your work, open Internet Explorer or Firefox, and view your web pages.  For example, the URL 
address for your consent form is:  
http://complabs.nevada.edu/~login/foldername/index.htm 
where login is your Novell login name or the name of your group and foldername is the name of the 
folder. 
 

Checking index.htm 
Type the URL address into the address bar, and your consent form should come up.  If your page does 
not appear, there are a couple of different things that might be happening.  If your Lab 3 worked fine, 
then your SCR account is working properly, and that is NOT the problem.  But if you never did get 
Lab 3 to work, the problem is probably with your SCR account.  Otherwise, the problem is probably 
with the URL address.  Check (a) the file name and foldername you are typing now exactly match the 
ones you saved the file under, including capitalization, (b) the SCR login you are typing now is the 
one you saved the file under, and (c) you used the right extension (I said to use .htm, but if you saved 
it as .html, the file name is different). 
 Once you get this file to open, check the links work.  When you click on the links, this should 
take you to your “No Thanks” page and your first questionnaire.  If not, you need to fix your links in 
Dreamweaver. 

 
Checking nothanks.htm 

When you click on the Return to UNLV link, you should be taken to the UNLV homepage.  If not, 
you need to fix the link in Dreamweaver. 

 
Checking identify.htm 

When you finish your identifying information questionnaire, you should be taken to the second 
questionnaire.  If not, you need to fix your Redirect URL’s in Event Handler.  If you instead click on 
“Quit the study now” on the Identifying Information questionnaire, you should be taken to the “No 
Thanks” page. 



Checking second.htm 
If you cannot get to the second questionnaire from the first questionnaire, you can still check your 
second questionnaire: type the address of the second questionnaire directly into the address bar.  
When you click on the Submit button on your second questionnaire, you should be taken to the 
debriefing form.  The “Quit the study now” link should also take you to the debriefing form. 

 
Checking debrief.htm 

To check your Debriefing form, make sure that when you click on the “Return to UNLV” link, you 
are taken to the UNLV homepage. 

 

Trying Out Your Study 
1. Try out your study.  Read every page and complete every question.  If anything doesn’t work, go back 

into Dreamweaver or Event Handler to fix it. 
2. Complete your study 4 or 5 times, giving different answers to your questions. 
3. Ask someone else to complete your study and to let you know if they find anything that could be 

improved. 
 

Exporting Your Data from Event Handler 
When people complete your study, the data from your two questionnaires will be sent to files that are 
saved on the Event Handler server.  To get your data, you have to export the data from each file 
separately. 
1. Open Event Handler and Log On. 
2. Select your first event. 
3. Click on the Event Navigation menu. 
4. Click on Export Data. 
5. Set the Delimiter as Semi-Colon. 
6. Set the Qualifier as None. 
7. Click Export. Your data will appear in a new window. 
8. Repeat these steps for your other questionnaire. 
If no data appears, even though you completed your study several times, there is something wrong with 
either your Event Handler event or with your Dreamweaver files.  The most common problem is that you 
deleted one or more of the html commands that specifies where the data should be sent.  If you copy and 
paste your html code from Event Handler into Dreamweaver again, this may fix the problem. 
 

What to Hand In 
Email me a list of the URL addresses for your five web pages.  Make sure that the addresses work by 
copying and pasting them into the address bar of Internet Explorer or Firefox BEFORE you send me the 
email. 
 

Extra Challenge: Going Beyond the Course 
If you want to create a more sophisticated web site, here are some ideas: 
1. Add pictures or clip art in appropriate locations. 
2. Design your study so that it asks participants how old they are, and if they are under 18, it sends them 
to another web page rather than letting them complete the study.  To do this, when people consent to 
participate, send them to a page that asks them how old they are.  You may want to call this page 
howold.htm.  If they click on a link that says that they are over 18, send them to the identify.htm page.  
Otherwise, send them to a new page that explains that they need to be over 18 to participate.  You may 
want to call this page sorry.htm 
3. Record your consent form using a microphone and a computer, save the recording as a .wav file, and 
insert it into your consent form so that it starts playing when the page is opened. 



4. People with disabilities often read web sites with the assistance of devises that read the page out loud.  
However, web sites have to be designed properly in order to be “readable” by these devices.  Use the 
software at http://webxact.watchfire.com to test your web site to see if it is accessible to people with 
disabilities and correct the problems it identifies. 
 
If you want to actually conduct your study, do the following 
1. Read the guidelines for the IRB proposal, available from the Office for the Protection of Research 
Subjects at http://www.unlv.edu/Research/OPRS/ under New Research Projects. 
2. Draft an IRB proposal and submit it to your faculty mentor for feedback.  See the example proposals on 
my web site for ideas about how to describe online research. 
3. After receiving approval from the IRB to conduct your research, advertise your study and collect your 
data. 
4. Once data collection is complete, analyze your results and present your findings at a conference such as 
Western Psychological Association (see http://www.westernpsych.org) or in a written journal article. 
 


